
Copyright	2017	Paperless	Transaction	Corporation	All	Rights	Reserved	

 

 

 

 

 

 

 

 

 

RDC 
User Guide 
VERSION 4.0 

 

  



	 	 RDC:	User	Guide	

Page	|	2																																													Copyright	2017	Paperless	Transaction	Corporation	All	Rights	Reserved	
	

 

Paperless Transaction Corporation 
433 E. Las Colinas Blvd.-Suite 840 
Irving, TX  75039 
www.paperlesstrans.com 
 

 

REVISIONS 

Version Date Description 
1.0 6/1/2008 First publication 
2.0 1/26/2009 Second publication (updated material from First publication) 
3.0 
4.0 

4/14/2010 Updated to align with latest application updates 
Updated to align with latest application updates 

PURPOSE 

This guide is intended for use by users of the RDC application. 
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Before You Begin 

If this is your first time using RDC, consider reviewing this section.  We’ve included some helpful 
information to get you started using RDC. 

Process Overview 
The following is a high-level overview of the check-processing steps. 

 

Figure 1: Process Overview 

Using this Guide 
We’ve attempted to make this guide as easy to use as possible.  Here are a few examples. 

More Information 
 

 

Look for this symbol when there is more information related to a topic. 
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When there is a reason to caution you or remind you of an important fact, we use 
this symbol to call attention to this information. 

 

Callouts 
Almost every graphic has callouts to draw your attention to particularly important functions. 

 

 

Process Steps 
Process steps are always numbered and shaded. 

1.  Step #1 Instructions 

2.  Step #2 Instructions 

3.  Step #3 Instructions 

Action Words 
To call your attention to the most important words in a process step, these words are in bold. 

 

The contents of this guide are available using online help.  See the Reviewing	the	
Online	User	Guide section of this guide for more information about using online help. 

Links to Other Sections of the Guide 
When there is a reference to another section of the guide, we have highlighted the section name 
and include a link to the referenced section.  For example: 

See the Logging	Out section of this guide. 

By clicking on the section name, you’ll be taken to this section without having to search for it. 

 

There may be RDC functionality described in this guide to which you do not have 
access.  Please contact your branch/site administrator if you believe you require 
additional access. 

Click	Login	Toolbar	

Figure	2:	Callout	Examples	
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Basic Navigation 
As you use the RDC application, you’ll discover how easy it is to use.  Starting and navigating the 
application is simple. 

The Toolbar 
The toolbar is used to access all the basic RDC functions.  For example, to begin the process of 
scanning items, you would click the Scan icon from the toolbar. 

 

 

Figure 3: Toolbar 

Table 1: Main Toolbar Icons 

Icon Description 

 
Use the scan function to scan checks and coupons, review and correct any scanned items, 
determine the status of items and upload batches. 

 
Use the queues function to review the contents of queues (Review, Hold, Approved, etc.). 

 
Use EPay to enter electronic payments (EPayment, ACH and Credit Card) 

 
Use Messages to send a message to FTNI or other RDC users. 

 
Use Search to search all data sources: local queues and remote storage.  A number of 
search options are available, including scan date, batch ID, item ID and dollar amount. 

 
Use reports to review the content of existing reports and create new ones. 

 
This will take you back to the home page, which is the first page you see when you log 
on. 

 
This will exit the application 

Basic	Functions	

Set-up	Options	
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Starting the RDC Application 
To start the RDC application, perform the following steps: 

1.  Click Start from your PC’s toolbar.  The Start window is displayed. 

2.  Click All Programs and locate FTNRDC. 

3.  Click FTNRDC.  You are prompted to login [Figure 4]. 

 

Logging In 
To login, perform the following steps: 

1.  At the login prompt, enter your Username, Password and Site. 

2. C Click Login. The home page is displayed [Figure 5] 
 

 

 

Figure 4: Login Prompt 

 

To work offline click Work Offline.  You will not need to enter your username, 
password or site abbreviation. 

Click	Login	

Enter	Username,	Password	
and	Site	Abbreviation	
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 When working offline you will only be able to scan items into the application.  You 
will not be able to upload scanned items or manage items in the queues.  Scanned 
items will be kept on local computers and not visible by other users.  To upload 
scanned items click Upload.  You will be prompted for your Username, Password and 
Site Abbreviation.  This will log you into the online site. 

 

 

Figure 5: Main RDC Page 

 

The home page depicted here may not match yours as your company may be using 
its home page instead. 

Toolbar	

Alerts	

Logon	Info	

Quick	Access	for	
Most	Used	Options	
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If you need assistance with your Username, Password or Site Abbreviation, contact 
your branch/site administrator. 

 

If you attempt to login unsuccessfully more than three times within a 20-minute 
period, your username will be revoked.  If this happens, contact your branch/site 
administrator. 

 

 

To return to the home page, from the toolbar, select the File menu drop-down and 
then click Home Page.  Or you can click on the Home icon from the toolbar. 

Logging Out 
When you are ready to logout, perform the following steps: 

1.  From the toolbar, select the File menu drop-down.  The list of File options is 
displayed. 

2.  Click Exit.  Your session is ended and the window closed. 
 

 

 

You can also log out by either clicking on the Exit button from the toolbar or closing 
the window. 

 

Session Timeout 
If your session is inactive for the period specified by your branch/site administrator, your session 
will be terminated.  The default inactivity period is 20 minutes. 

 

Because you have access to sensitive customer information, be sure to lock or logoff 
your session whenever you leave your computer. 

Using Help 

Reviewing the Online User Guide 
To view the online version of this user guide, perform the following steps: 

1.  From the toolbar, select the Help menu drop-down.  The list of Help options is 
displayed. 

2.  Click Contents.  The Help window is displayed. 

3.  Use the Table of Contents in the left navigation pane to locate the needed topic. 
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Determining the RDC Version You’re Using 
To determine the version of the RDC application you’re using, perform the following steps: 

1.  From the toolbar, select the Help menu drop-down.  The list of Help options is 
displayed. 

2.  Click About.  The About FTNI RDC window is displayed [Figure 6]. 

3.  When finished, click OK.  The window closes. 
 

  

Figure 6: About FTNI RDC Window 

Viewing the Event Log 
To view the event log, perform the following steps: 

1.  From the toolbar, select the Help menu drop-down.  The list of Help options is 
displayed. 

2.  Click Event Log.  The About Event Viewer window is displayed [Figure 7]. 
 

Version	

When	Finished,	
Click	OK	
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Figure 7: Event Viewer Window 

 If there are events in the log you would like to forward to your support area, 
highlight the event entries and click Send to Support. 
 
You can also copy entries to an email by highlighting the entries, clicking Copy to 
Clipboard and pasting into the body of an email. 
 
To clear the contents of the events list, click Clear. 

 

List	of	Events	

Use	the	Send	and	Copy	buttons	to	
forward	content	from	the	Event	Viewer		
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Scanning Items 

There are three basic scanning functions: 

§ Scan Control: Performing the scan. 
§ Scan Review: Reviewing the scan results, making any needed adjustments and determining 

the status. 
§ Scan Repair: Any items that do not meet standard field validation or business field 

validation will be displayed in the Scan Repair tab.  These items must be repaired before 
uploading the items. 

 

In order to perform the scanning process, your PC must have access to a scanner.  
For more information about configuring the RDC application to use your particular 
scanner model, contact your branch/site administrator.  For questions about 
modifying the contrast and image quality of your scanner, see the Changing	the	Scan	
Configuration section of this guide. 

Navigating the Scan Control Tab 
Using the Scan Control tab, you can perform the following functions: 

§ Scan items into review, approve or hold status 
§ Change the parameter settings for a batch of checks 
§ Endorse the physical check and/or the check image 



	 	 RDC:	User	Guide	

Page	|	18																																													Copyright	2017	Paperless	Transaction	Corporation	All	Rights	Reserved	
	

 

 

Figure 8: Scan Window – Scan Control Tab 

Scan Selection Fields 
The Scan Selection Fields must be set before you begin scanning each batch of checks. 

Table 2: Scan Selection Fields 

Scan Option Description 

Default Status 

Select the status into which you’d like to scan the item(s): 
§ Review 
§ Approve 
§ Hold 

 
For example, if your company does not require a review step, you may wish to 
select Approve. 

Prefer As Select the image (Check21) or ACH option that is appropriate for your company. 

List	of	
Scanned	
Items	

Tabs	 Scan	Selection	Fields	

Scan	Control	
Upload	

Scan	Options	
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Scan Option Description 

Upload 

If you wish for scanned items to be immediately uploaded, select Batch Item. 
 
If you select Batch End, the upload will be performed after the batch is 
scanned.  In Batch End mode, you must hit the Upload button to upload. 
 
If you select Continuous, the scanner sits ready to scan and will scan items as 
soon as an item passes through the scanner’s sensor.  Using the continuous 
option the items are uploaded immediately and the scan is not completed until 
you hit the Cancel button. 

Scan Options 
When scanning, you can use a combination of any or none of the scan options. 

Table 3: Scan Options 

Scan Option Description 

Validation 

Use this option when you wish to verify the totals (number of checks and total 
amount of batch) of a manual count.  Select the option and enter the manual 
totals. 
 
For example, if the batch consisted of 100 items for a total of $2,505.75, the 
Validation option would be selected and the totals would be entered as follows: 

 

Settlement 

Use this option to select the settlement account for which the items will be 
deposited. 
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Scan Option Description 

Coupon 

If you will be scanning coupons, use this option to specify the coupon type and 
the coupon order (before or after the check). 

 

Endorsement 

Use this option to create a physical (on the actual check) or a virtual (on the 
check image) endorsement. 

 
The following is an example of a virtual endorsement: 

 

No Option 

If you don’t wish to use an option, it should not be selected. 

 

Starting a Scan 
To start a scan, perform the following steps: 

1.  Ensure the scanner is ready to scan. 

Virtual	Endorsement	
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2.  From the toolbar, click the Scan icon. 

 
The Scan page is displayed. 

3.  Select the Scan Control tab [Figure 8]. 

4.  Ensure the following fields have the appropriate selections: 
§ Default Status 
§ Prefer As 
§ Upload 

 
For more information about using these fields, see the Uploading	Items section of 
this guide. 

5.  Ensure the appropriate scan options (i.e., validation, settlement, etc.) are selected.  
For more information about using the scan options, see the Scan	Options section of 
this guide. 

6.  Click Start Scan.  The scanner begins the process of scanning the item(s) and the 
list of scanned items is displayed [Figure 10].  When the scan is complete, a 
confirmation message is displayed [Figure 9]. 

 
7.  Click OK.  Depending on your company’s process, the scanned items may now be 

reviewed or uploaded. 
 

 

Figure 9: Scan Complete Confirmation Prompt 
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Figure 10: Scanned Items List Example 

 

For more information about scan errors, see the Interpreting	Scan	Errors	[Image	
Quality] section of this guide. 

Stopping a Scan in Progress 
To stop a scan in progress, click Stop Scan.  The scan stops. 

 

Restarting a Stopped Scan 
If you have stopped a scan in progress but have not yet cleared the scanned item list, you may 
restart the scan by clicking Start Scan. 

Items	with	Scan	Errors	

Items	without	Scan	Errors	
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Clearing Scan Results 
To clear the results of a scan, click Clear Items.  The scanned items list is cleared. 

 

A scan may not be active while you are attempting to clear the scanned items list. 

Uploading Items 
Once items have been scanned into a batch, they can be uploaded.  Until the items are uploaded 
they are kept on the local PC.  Once the items are uploaded they are stored on a secure central 
server. 

To upload a batch, perform the following steps: 

1.  From the toolbar, click the Scan icon. 

 
The Scan page is displayed. 

2.  Select the Scan Control tab [Figure 8]. 

3.  Click Upload.  The batch is uploaded to FTNI for processing.  Items in the Approved 
Que will be sent to the bank based on individual bank 
policies. 
 
 
 
 
 

 

 

If the Batch Item option or the Continuous option has been selected (i.e., once an 
individual item is scanned, it is uploaded immediately), you do not need to upload 
those items manually.  Only items scanned into batches require this procedure to be 
performed. 
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Working with Scanned Items 

Navigating the Scan Review Tab 
Using the Scan Review tab, you can perform the following functions: 

§ Modify item details 
§ Change item status (i.e., approve, hold, review and error) 
§ Review the item’s image and Change Log 
§ Discard or Rescan items 
§ Enter Notes and custom data 

 

Figure 11: Scan Window - Scan Review Tab 

Status	Change	

Item	
Image	

Item	
Detail	

Item	
Navigation	

Item	Action	(scan	config,	
rescan,	delete)	

Log/Ledger	Selection	

Notes	

Tabs	
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Reviewing Scanned Items 
To review a scanned item from the Scan Review tab, simply double click on the item in the Scan 
Control grid you wish to review or click the Scan Review tab heading.  The Scan Review tab is 
displayed with the selected item. [ Figure 11]  This is universal throughout the application.  A 
review screen will pop up anytime you double click on a line item. 

To edit a field within the Scan Review tab, highlight the field you wish to edit and enter the data.  
The data is saved automatically. 

To edit the MICR line information, click Edit in the Scan Data section and edit the information.  
When finished, click Lock in the Scan Data section 

For more information, see the Modifying	an	Item’s	Detail	or	Status section of this guide. 

Interpreting Scan Errors [Image Quality] 
When items are scanned, their image quality is determined and any potential problems are flagged 
using a simple color coding system.  The image quality standards are determined by your 
company’s administrator. 

Table 4: Image Quality Indicators 

Image Quality Description 

Acceptable 
[White] 

 

May Require Review 
[Yellow] 

 

Unacceptable 
[Red] 

 
 

 

 

The reason for an item to be flagged can be either a low CAR/LAR score, surpassing 
an IQA threshold and/or bad or missing MICR line information.  To review the 
reason, click on the Quality Assurance log.  For more information, see the Reviewing	
the	Quality	Assurance	Log section of this guide. 
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Changing Item Status 
For more information about changing item status, see the Modifying	an	Item’s	Detail	or	Status 
section of this guide. 

Modifying Item Details 
For more information about modifying item details, see the Modifying	an	Item’s	Detail	or	Status 
section of this guide. 

Changing the Scan Configuration 
To change the scan configuration, perform the following steps: 

1.  Ensure the scanner is ready to scan. 

2.  From the toolbar, click the Scan icon. 

 
The Scan page is displayed. 

3.  Select the Scan Review tab [Figure 11]. 

4.  Click the Scan Configuration icon.  The Scan Configuration pop-up window is 
displayed [Figure 12].  You can also reach the Scan Configuration pop-up window 
through the setup menu listed at the top of the RDC application. 

 
5.  Make the needed configuration changes. 

6.  Click Apply.  The changes are applied and the pop-up window closes. 
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Figure 12: Scan Configuration Pop-up Window 

Discarding an Item from the Review Window 
To discard an item from a review window, perform the following steps: 

1.  From the toolbar, click the Scan icon. 

 
The Scan page is displayed. 

2.  Select the Scan Review tab [Figure 11]. 

3.  Locate the item to be discarded.  (The item needs to be displayed.) 

4.  Click the Discard icon.  You are prompted to confirm the discard.[Figure 13] 

 
5.  Click OK to discard the item. 
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Figure 13:  Discarding an item 

Rescanning an Item 
To start a rescan an item, perform the following steps: 

1.  From the toolbar, click the Scan icon. 

 
The Scan page is displayed. 

2.  Select the Scan Review tab [Figure 11]. 

3.  Locate the item to be rescanned.  (The item needs to be displayed.) 

4.  Ensure the scanner is ready to scan the item. 

5.  Click the Rescan icon.  You are prompted to confirm the scanner is ready [Figure 
14]. 

 
6.  Click OK.  The item is scanned and the record is updated. 
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Figure 14: Rescan Item Confirmation Prompt 

Navigating the Scan Repair Tab 
Using the Scan Repair tab you can repair those items that don’t meet standard validation rules 
and/or site specific validation rules.  You can perform the following functions in the Scan Repair 
tab: 

• Repair misread MICR lines 
• Repair invalidated customizable fields 

Items that need repair are automatically placed in the Scan Repair tab.  [Figure 15] 
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Figure 15:  Scan Repair Tab 

Repairing an Item 
To repair an item, perform the following steps: 

1.  Ensure there is an item that needs to be repaired.  Anytime an item needs to be 
repaired, it is automatically placed into the Scan Repair tab and a running count in 
parenthesis is displayed on the tab.  In the Scan Repair tab, the image of the item 
needing repair is displayed as well as the fields that need to be repaired.  The fields 
that need repair are highlighted in red.  There is also a display that informs you of 
the next field that needs to be repaired. 

2.  Click on the first field that needs to be repaired and enter the correct information. 

3. C Click Next.  The next field needing repair is displayed, either on the same scanned 
item or on the next item. 

Item	
Image	

Repair	Fields	

Running	Count	 Next	Field	Button	

Status	Message	
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4. W When all the fields have been repaired the following message is displayed: 

 
5.  Once all items have passed validation, the batch can be uploaded.  To upload items 

see Uploading	Items section of this guide. 
 

 

Some validation fields are required to be repaired prior to uploading. 
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Working with Queues 

Scanned items are organized into queues in order to manage a potentially high volume of data.  
There are six basic queues: 

Table 5: Queue Descriptions 

Queue Status 

Review Scanned items that have not yet been transmitted 

Hold Items that have been identified as not being ready for transmission 

Approved Items that are ready for transmission 

Transmitted Items that have been transmitted 

Return Items that have been returned (not paid) 

Error Items that have not scanned or transmitted correctly 

Navigating Queues 
Using the Queues window, you can perform the following functions: 

§ Review the totals (number of items and dollar amount) for each queue 
§ Review the contents of each queue 
§ Change the status of selected items 
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Figure 16: Queues Window 

Viewing the Contents of a Queue 
To view the contents of a queue, click the toggle button (at the left of the queue bar).  The queue 
expands, revealing the items it contains. 

To close the detail view of a queue, click the toggle button again.  The queue collapses to the bar 
view. 

Locating an Item 
To locate a specific item in a queue, you can easily do so by sorting the queue in which you believe 
it is contained.  You can then sort the queue by the column that will make it easiest to locate the 
item. 

Queue	Items	

Queue	Detail	
Toggle	Button	

Queue	Totals	

Company/Subsidiary	
Selection	

Click	on	the	Column	
Headings	to	Sort	

Queue	Name	&	
Company/Subsidiary	

Item	Type	Filters	
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For example, if you know the amount of the item, click the Amount column heading.  The column 
will then sort the entire queue by amount in ascending order.  If you wish to sort the queue in 
descending order, simply click the Amount column heading again.  Note that the arrow in the 
heading column will now be pointing down.  See the column heading examples below. 

 

 

Ascending	Sort	 Descending	Sort	

Figure	17:	Queue	Column	Sorting	Example	
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Modifying an Item’s Detail or Status 

Changing the Status of Selected Items 
To modify an item’s detail, perform the following steps: 

1.  If you’re not using the Scan Review tab of the Scan Window, locate the item you 
wish to modify and double-click anywhere on the item line.  The Review Detail 
window is displayed [Figure 18], populated with the item’s detail. 

2.  Use the Item Action buttons or the Item Action drop-down menus to change the 
status of the item. 

3.  If you specify See Notes as a reason for the current status, be sure to enter your 
comments/directions in the Notes and Custom Data field. 

4.  To move to the next item, use the item scroll arrows. 

5.  If using the Review Detail window, when finished, close the window. 
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Figure 18: Review Detail Window 

 

If you set an item’s status to Discard, the item will not be displayed in any of the 
queues.  The only way to view that item is through the Search Function.  For more 
information see the Performing	Searches section of this guide. 

 

Once an item has been transmitted, its status and most fields cannot be changed. 

Click	Edit	to	Begin	
Modifying	Item	Detail	

Item	Action	
Drop-downs	

Item	Scroll	Arrows	

Item	Images	
View	Menu	

Notes	

Current	Status/	
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Once you’ve opened an item in the Review Detail screen, you can use the scroll 
arrows to review the items in the queue. 
 
 
 
 
 
 
 

Modifying Item Detail 
To modify an item’s detail, perform the following steps: 

1.  Locate the item you wish to modify and double-click anywhere on the item line.  
The Review Detail window is displayed [Figure 18], populated with the item’s 
detail. 

2.  Click Edit.  The previously protected fields (shaded in grey) can now be edited. 

3.  When finished editing, click Lock and close the window.  The changes you made are 
saved. 

Item Detail Fields 
The following is the list of item detail fields. 

Table 6: Item Detail Fields 

Field Description 

EPC Code External Processing Code. 

Aux On-Us Auxiliary On Us Field. 

ABA # Routing number (American Banking Association #). 

Account # Bank account number. 

Check # Check number. 

Amount Check amount. 

Type Image and ACH options. 

Settlement Settlement account. 

As of Date 
The default is the scan date, but users can set this date either in the past or 
the future. 

Deposit Date 
The default is the scan date, but users can set a date in the future.  The item 
will not be transmitted to the bank until the Deposit Date is reached. 

Payor Payor name (first name, middle initial and last name). 

First	Item	in	
the	Queue	

Last	Item	in	
the	Queue	

Previous	Item	 Next	Item	



	 	 RDC:	User	Guide	

Page	|	38																																													Copyright	2017	Paperless	Transaction	Corporation	All	Rights	Reserved	
	

Field Description 

Notes and Custom 
Data 

Notes related to status. 

F1 –F3 
Your company may use these fields to retain particular types of data.  If you 
don’t know how these fields are used, contact your branch/site administrator. 

Right-Click Menu Options 
From the Scan Review and Scan Repair tabs of the Scan page and the Queues page, you may right-
click on an item or group of items and a list of menu options is displayed [Figure 19].  Using this 
menu, you can change the status of f a single item or multiple items easily. 

 

Figure 19: Right Click Menu 

Table 7: Right-Click Menu Options 

Menu Option Description 

Approve Selected Moves the highlighted items to the Approved Queue. 

Approve All Moves all items within that queue to the Approved Queue. 

Review Selected* Moves the highlighted items to the Review Queue. 

Review All* Moves all items within that queue to the Review Queue. 

Hold Selected Moves the highlighted items to the Hold Queue. 

Hold All Moves all items within that queue to the Hold Queue. 

Error Selected Moves the highlighted items to the Error Queue 

Discard Selected 
Discarded items will not be shown in any queue.  Visibility to discarded 
items is only available via the search function 

Refresh Refreshes the information within that queue 
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Menu Option Description 

Export This will display the Export Data window. 
*Not shown on figure above 

 

Depending on your entitlement settings, you may not be able to view the Export 
Data window.  For access, contact your administrator. 

 

Using Hotkeys 
From the Scan Review and Scan Repair tabs of the Scan page, you can use hotkeys to change the 
status of an item or group of items. 

Table 8: Scan Review and Scan Repair Hot Keys 

Hot Key Description 

Alt + A Changes the item’s status to Approve. 

Alt + H Changes the item’s status to Hold. 

Alt + R Changes the item’s status to Review. 

Alt + E Changes the item’s status to Error. 

Alt + F Displays the first item in the queue in which you are working. 

Alt + L Displays the last item in the queue in which you are working. 

Alt + N Displays the next item in the queue in which you are working. 

Alt + P Displays the previous item in the queue in which you are working. 
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Reviewing Logs 

The RDC application maintains two types of logs:  

§ Change Log – If an item is changed after it is created, it is recorded in the Change Log. 
§ Quality Assurance Log – The RDC application assesses the quality of the image, MICR, etc. 

and records this information. 
§ Ledger – The default view is the Ledger.  It may be used to capture payment data used for 

back-office integration. 

 

Figure 20: Reviewing Logs Menu 

View	Drop-
down	Menu	
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Navigating the Logs 
To review a log, locate the View drop-down menu [Figure 21] in either the Scan Review tab or in 
the Review Detail screen and select the log you wish to review.  The log is displayed. 

 

Figure 21: View Drop-down Menu 

Using the Ledger 
Depending on your business needs and rules, you may work with the ledger section of the review 
screen.  The ledger section is a user-defined customizable ledger which can be reflected in many 
different manners.  It acts as a basic ledger. 

 

Figure 22: Ledger Example 
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Reviewing the Quality Assurance Log 
To view the Quality Assurance Log, locate the View drop-down menu in either the Scan Review tab 
or in the Review Detail screen and select Quality Assurance Log.  The quality Assurance Log is 
displayed. 

 

Figure 23: Quality Assurance Log Example 

Quality Assurance Log Fields 
The following is the list of Quality Assurance Log fields. 

Table 9: Quality Assurance Log Fields 

Field Description 

Source Source of the image. 

Field Attribute that is being assessed. 

Value Number representing the quality of the attribute being assessed. 

Info Description of the value ranges (e.g., highest possible value). 
 

If an item is flagged, you can use the Quality Assurance Log to determine the reason. 
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Figure 24: Flagged Item's Quality Assurance 

Reviewing the Change Log 
To view the Change Log, locate the View drop-down menu in either the Scan Review tab or in the 
Review Detail screen and select Change Log.  The Change Log is displayed. 

 

Figure 25: Change Log Example 

Change Log Fields 
The following is the list of Change Log fields. 

Table 10: Change Log Fields 

Field Description 

Time Date and time when change occurred. 

User User who performed the action that result in the change. 

Field Field that was changed. 

Old Value of the field prior to the change. 

New Value of the field after the change. 
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EPay (Note: The EPay module is not turned on by default.) 

There are three types of electronic payments the application can transmit: 

• EPayment 
• ACH Terminal 
• Credit Card Terminal 

All of these payment types are entered in the Epay section of the application. 

Navigating the EPay Window 
Using the application you can save customer’s contact information, banking information and 
payment profiles.  Doing this provides for quicker and more efficient payment processing. 

 

Figure 26: EPay Page 

When	Ready,	
Click	Submit	

Search	Function	

Search	Results	
Window	 Payment	Details	

Transaction	Summary	

Customer	Setup	

Payment	Type	
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Creating a New Customer and Payment Method 
To create a new customer, perform the following steps. 

1.  From the toolbar, click the EPay icon. 

 
The EPay page is displayed. 

2.  Click on the New option (in the Client Information area at the top of Epay page) 
[Figure 26].  This will open the customer information section and collapse all of the 
other sections.  The Add Customer and Add Pay Method forms are displayed [Figure 
27]. 

3. S To set up the customer, perform the following steps: 
a. Select either Individual or Business. 
b. Enter the required information along with any of the additional information 

you would like to retain (in the Notes field). 

4.  To set up the payment method, perform the following steps: 
a. Select either Bank or Card. 
b. Enter the required information. 

5.  Click Save.  The customer and payment method are created. 
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Figure 27: Add Customer and Add Pay Method Forms 

 

To cancel the creation of a new customer, simply click Cancel.  You'll be returned to 
the main EPay window.  And to clear the forms and start over, simply click Clear. 

Searching for Customers 
To search for customers, perform the following steps. 

1.  From the toolbar, click the EPay icon. 

 
The EPay page is displayed. 

2.  From the Search options area of the EPay page [Figure 26], select the Site. 

When	Finished,	Click	Save	

Customer	Detail	

Payment	Method	Detail	
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3.  Enter the name (or part of it) of the customer for which you are searching and click 
Search. 

 
The list of customers matching the name information you entered is displayed. 

Creating an EPayment 
To create a new EPayment, perform the following steps. 

1.  From the toolbar, click the EPay icon. 

 
The EPay page is displayed. 

2.  Locate the customer for which you will be making a payment (see the Searching	for	
Customers section for more information about doing this). 

3.  Click EPayment.  The EPayment form is displayed [Figure 28]. 
 
Note: This is the form that displays by default. 

4.  Enter the required information and click Submit. 

 
The payment is submitted and a confirmation message is displayed [Figure 29]. 
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Figure 28: EPayment Form 

 

Figure 29: EPayment/ACH Confirmation Message 

Creating an ACH Payment 
To create a new ACH payment, perform the following steps. 

1.  From the toolbar, click the EPay icon. 

 
The EPay page is displayed. 

2.  Locate the customer for which you will be making a payment (see the Searching	for	
Customers section for more information about doing this). 
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3.  Click ACH Terminal.  The ACH form is displayed [Figure 30]. 

4.  Enter the required information and click Submit. 

 
The payment is submitted and a confirmation message is displayed [Figure 29]. 

 

 

Figure 30: ACH Form 

Creating a Credit Card Payment 
To create a new Credit Card payment, perform the following steps. 

1.  From the toolbar, click the EPay icon. 

 
The EPay page is displayed. 

2.  Locate the customer for which you will be making a payment (see the Searching	for	
Customers section for more information about doing this). 

3.  Click CC Terminal.  The Credit Card form is displayed [Figure 31]. 

4.  Select the tab corresponding to the type of transaction (i.e., Sale, Credit, Void, etc.) 
you will be submitting. 
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5.  Enter the required information and click Submit. 

 
The payment is submitted and a confirmation message is displayed [Figure 32].  
The confirmation message indicates whether the transaction was approved or 
declined. 

 

 

A Credit Card transaction is a submitted for payment immediately. 

 

 

Figure 31: Credit Card Form 
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Figure 32: Credit Card Confirmation Message 

Creating a Recurring Payment 
You can enter recurring payments for ACH payments and based on daily, weekly, monthly or yearly 
intervals.  To create a recurring payment, perform the following steps: 

1.  From the toolbar, click the EPay icon. 

 
The EPay page is displayed. 

2.  Locate the customer for which you will be making a recurring payment (see the 
Searching	for	Customers section for more information about doing this). 

3.  Click EPayment.  The EPayment form is displayed [Figure 28]. 
 
Note: This is the form that displays by default. 

4.  From the Recurrent section of the page, click Setup. 

 
The Recurring Payment form is displayed [Figure 33]. 
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5.  Enter the required information and click Save. 

 
The recurring payment is submitted and the details are displayed in the Recurrent 
section of the page. 

 
 

 

The status of a recurring credit card payment must be Approve. 

 

Figure 33: Recurring Payment Form 

Reviewing Transactions 
To review transactions for a selected customer, perform the following steps. 
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1.  From the toolbar, click the EPay icon. 

 
The EPay page is displayed. 

2.  Locate the customer for which you will be reviewing transactions (see the 
Searching	for	Customers section for more information about doing this). 

3.  From the Transaction section of the page, double-click the transaction group.   The 
list of pending and processed payments is displayed [Figure 34]. 

4.  Double-click on any of the transactions to view the full detail.  The Review Detail 
page is displayed populated with the payment detail [Figure 35]. 

 

 

A pending payment may be changed.  However, a processed payment cannot be 
changed 
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Figure 34: Payment (Pending and Processed) Transaction Detail Forms 
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Figure 35: Review Detail Page 
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Messaging 

Navigating the Message Window 
Using the Message window, there are several message-related actions that can be performed: 

§ Create a message 
§ Save a message to a file outside the RDC application 
§ Print a message 
§ Delete a message 
§ Replay to a message 
§ Forward a message 

 

Figure 36: Messages Window 
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Table 11: Messages Toolbar Icons 

Icon Description 

 
Displays a new Message window. 

 
Saves the selected message. 

 
Prints the selected message. 

 
Deletes the selected message. 

 
Initiates a reply to the selected message. 

 
Begins the process of forwarding the selected message. 

 
Refreshes the Messages window.  Essentially, this checks for new messages. 

Reviewing Your Messages 
To review your messages, perform the following steps: 

1.  From the toolbar, click the Messages icon. 

 
The Messages window is displayed [Figure 36]. 

2.  Select the Inbox or Sent Items using the View drop-down menu. 

 
The message list of the selected source (Inbox or Sent Items) is displayed. 

3.  From the list of messages, click on each.  The contents of each message is 
displayed (to the right of the list). 
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Sending a Message 
You can send messages to other users of the application and to your application support staff.  To 
send a message, perform the following steps: 

1.  From the toolbar, click the Messages icon. 

 
The Messages page is displayed [Figure 36]. 

2.  From the message toolbar, click the New icon.  The New Message window is 
displayed [Figure 37]. 

3.  Use the To drop-down menu to select the recipient. 

4.  When sending a message to Support or Customer Service, select a Category. 

5.  Enter the Subject and type your message. 

6.  When you have finished, click Send.  Your message is sent. 
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Figure 37: New Message Window 

Saving a Message's Contents to a File 
To save the contents of the selected message to a file, simply click the Save As.  You are then 
prompted for the file's location, name, etc. 

 

Printing a Message 
To print the selected message, simply click the Print icon. 

Message	Contents	

Message	Subject	

When	Ready,	Click	Send	

Message	Formatting	

List	from	which	to	
Choose	Recipients	

List	of	Categories	for	
Messages	to	FTNI	
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You are prompted to select the printer.  Do so and click OK.  Your report is printed. 

Deleting a Message 
To delete the selected message, simply click the Delete icon. 

 

You are prompted to confirm your choice. 

 

Click OK.  The message is deleted. 

Replying to a Message 
To reply to a message, perform the following steps: 

1.  From the toolbar, click the Messages icon. 

 
The Messages page is displayed [Figure 36]. 

2.  Select the message to which you are replying. 
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3.  From the message toolbar, click the Reply icon. 

 
The New Message window is displayed populated with the content of the original 
message[Figure 37]. 

4.  Type your reply. 

5.  When you have finished, click Send.  Your reply message is sent. 

Forwarding to a Message 
To forward to a message, perform the following steps: 

1.  From the toolbar, click the Messages icon. 

 
The Messages page is displayed [Figure 36]. 

2.  Select the message you are forwarding. 

3.  From the message toolbar, click the Forward icon. 

 
The New Message window is displayed populated with the content of the original 
message[Figure 37]. 

4.  Use the To drop-down menu to select the recipient. 

5.  When sending a message to Support or Customer Service, select a Category. 

6.  Modify the Subject, if necessary and type your reply. 

7.  When you have finished, click Send.  Your message is forwarded. 

Refreshing the Message List 
To refresh the message list (i.e., to check for new messages), simply click the Refresh icon. 
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The list of messages in your Inbox is refreshed. 
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Performing Searches 

RDC’s search function provides you with the ability to search for a range of items or a specific item.  
You can also specify that the search be performed  on Remote Storage (items that have been 
uploaded) or Archive Storage (records older than 90 days).  In addition, you can also specify 
whether all sites/branches should be searched or a specific site/branch should be targeted. 

 

Figure 38: Search Window 
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Search Parameters 
Any combination of the following search parameters may be specified. 

Table 12: Search Parameters 

Search Parameter Description 

Search Scope 
If you select Remote Storage, uploaded items will be searched, and if you 
select Archive Storage, records older than 90 days will be searched. 

Site 
If your company has more than one site/branch, you may select a specific 
branch/site, or you may choose Any to search all sites/branches. 

Type You may specify the item type (i.e., Check, EPay ACH, etc.). 

Scan Date Range 
You may specify a range of dates on which scans were performed.  Using the 
pull down menu, you can also specify Any Date for a range. 

Batch ID Range 
Unique IDs are assigned to every batch.  You may specify a range of batches 
through which to search. 

Item ID Range 
Unique IDs are assigned to every item.  You may specify a range of item IDs 
through which to search. 

Dollar Amount 
Range 

You may specify a range of scanned dollar amounts. 

Settlement Amount You may specify a range of settlement dollar amounts. 

Entered By 
You may specify the person (or department, depending on how your 
company assigns user names). 

Item Status You may specify a status (i.e., review, approved, hold, etc.) 

ABA # or CC Ref You may specify a specific ABA (routing) number. 

Account or CC # You may specify a specific account or credit card number. 

Check Number or 
CC Cust 

You may specify a specific check number. 

Payor Last You may specify the payor’s last name. 

Custom Fields 1-3 
Your company may use these fields to retain particular types of data.  If you 
don’t know how these fields are used, contact your branch/site administrator. 

Ledger Fields You may search for any information that is saved in the Ledger. 

Change Log Fields You may search for any information that is saved in the Change log. 

IQA Log Fields You may search for any information that is saved in the IQA log. 

Performing a Search 
Once you have specified the search parameters, click Search to initiate the search.  The search 
results are displayed. 
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To view the detail of a specific item, double-click anywhere on the item line.  The Review Detail 
window is displayed [Figure 18], populated with the item’s detail. 

Clearing Search Parameters 
To clear the search parameters, simply click Clear.  All the search parameters are reset to their 
default values and you are ready to start another search. 
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Reports 

There are many reports offered which cover a wide variety of results.  Each report has a small set 
of parameters (e.g., date(s), site(s), etc.) that can be entered to provide you wish exactly the data 
you need. 

 

Custom reports are normally provided based on business needs.  If you do not see a 
report that you need to have, contact customer support. 

Running a Report 
To run a report, perform the following steps: 

1.  From the toolbar, click on the Report icon. 

 
The Reports page is displayed. 

2.  Select the report you wish to run. [Figure 39] 

3.  Select the parameters for the report (e.g., date(s), site(s), etc.). 

4.  Click on the Run button (on the right side of the page). 

 
Your report is displayed at the bottom of the page. 

5.  To view any additional pages of the report, use the arrow buttons at the top of the 
report. 

 

 If you have a multi-page report, you can use the scroll arrows to review the pages of 
the report. 
 

 
 

First	Page	 Last	Page	

Previous	Page	 Next	Page	
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Figure 39: Report Example 

Preparing a Report to Print 
To view the page setup of a report, simply click the Page Setup icon. 

 

The Page Setup window is displayed.  Make any needed changes and click OK.  Your print settings 
are saved. 
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Viewing a Report's Page Layout 
To view a report's page layout (the way it will look when printed), simply click the Page Layout 
icon. 

 

Printing a Report 
To print a report, simply click the Print icon. 

 

You are prompted to select the printer.  Do so and click OK.  Your report is printed. 

Creating an Excel or a PDF Version of a Report 
To create an Excel or PDF version of your report, simply click the Save icon's drop-down menu and 
select your choice of output.  You are then prompted for the file's location, name, etc. 
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Managing User Options 

You can customize many of the RDC settings using the Options Administration window.  In 
addition, you can restore all the customizable options to their default settings. 

Modifying User Options 
To modify the user’s options, perform the following steps: 

1.  From the toolbar, select the Setup menu drop-down.  The list of Setup options is 
displayed. 

2.  Click Options.  The Options Administration window is displayed [Figure 40]. 

3.  From the options command bar, click Edit User Options.  The previously protected 
fields (shaded in grey) can now be edited. 

4.  Make the needed modifications to any of the options by using the tabs (Scan, 
Ledger, Queue, Search and Export) to navigate among the option groups.  See the 
sections below for more information about each option group. 

5.  When finished, click Save.  The option customizations are saved. 
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Scan Options 

 

Figure 40: Options Administration Window - Scan Tab 

 
Table 13: Scan Options 

Scan Option Description 

Scanner Scanner type 

OCR Level The user’s OCR level 

CARLAR Threshold 
These settings determine what the thresholds are for a CARLAR score 
warning or an error when an item is scanned.  Every item receives a CARLAR 
score and if the score is below the thresholds, then an action could be taken 

Click	Edit	to	
Customize	Options	

Click	Reset	to	Return	Options	
to	Their	Default	Settings	

Click	Save	When	Finished	

Option	Category	Tabs	
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Scan Option Description 

Action This determines what action is taken when the thresholds are not met 

Default Status Default status of scanned items 

Upload Behavior Default settings of the upload behavior 

On Scan Error Default setting for a physical scanning error 

Default Review 
Grid 

Default view for the review grid 

Validation Default settings for validation 

Settlement Default settings for settlement 

Coupon Default settings for coupon 

Endorsement Default settings for endorsement 
 

 

When the default setting for Validation, Settlement, Coupon and Endorsement is 
turned on, additional settings must be chosen.  For example, If you turn on 
endorsements, you have to select what endorsement to use. 
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Ledger Options 
Users can customize the ledger that is inside the review grid.  This allows users to add information 
to items that have been scanned.

 

Figure 41: Options Administration Window - Ledger Tab 

Table 14: Ledger Options 

Ledger Option Description 

Disable Ledger Disables the ledger capabilities 

Label Name 
The name of the field or column.  This will be displayed in the review grid of 
the application 

Type 
Determines whether the field/column is a text box or a pull-down selection 
box 

Click	Save	When	Finished	
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Ledger Option Description 

Values 

If the field/column is a combo type, this is where the user would enter the 
different selections.  The first line entered in the values box will be the 
default in the application.  If you do not want a default, place an empty line 
for the first line. 

Total 
If the values in the column are numbers, selecting total will display a total in 
the review grid.  Only one column can be totaled. 

Visible Determines whether a field/column is visible 

Queue Options 

 

Figure 42: Options Administration Window - Queue Tab 

Use	the	arrows	to	move	column	
headings	between	the	two	groups	

Click	Save	When	Finished	
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Table 15: Queue Options 

Queue Option Description 

Number of Items 
per Page 

Number of pages to display per page 

Queue Name 

Use this field to select the queue for which you wish change column 
settings.  For example, if you want to change the column settings for the 
Review queue, select this queue and begin making changes to the column 
settings. 

Hidden/Visible 
Columns 

Hidden columns are not displayed and visible columns are displayed.  Use 
the arrow buttons to move column headings between the two groups. 

Search Options 

 

Figure 43: Options Administration Window - Search Tab 

Use	the	arrows	to	move	column	
headings	between	the	two	groups	

Click	Save	When	Finished	
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Table 16: Search Options 

Search Option Description 

Hidden/Visible 
Columns 

Hidden columns are not displayed and visible columns are displayed.  Use 
the arrow buttons to move column headings between the two groups. 

Export Options 

 

Figure 44: Options Administration Window - Export Tab 

Table 17: Export Options 

Export Option Description 

Auto Export This turns the auto export feature on, based on the output trigger 

Use	the	arrows	to	move	field	
names	between	the	two	groups	

Click	Save	When	Finished	
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Export Option Description 

Output Trigger 

This determines when the export takes place.  With the trigger set on 
commit; the export takes place when a change is made to an item that 
requires resaving.  With the trigger set to approval, the export takes place 
when the item’s status is changed to approve. 

Directory This is the extension where the exported items will be exported to 

Delimiter This field determines how the exported fields are separated 

Image Handling This field determines how the images are exported 

Available/Included 
Fields 

Available fields are not exported and included fields are exported.  Use the 
arrow buttons to move field headings between the two groups. 

Resetting User Options to the Default Settings 
You can reset user options to their default settings by performing the following steps: 

1.  From the toolbar, select the Setup menu drop-down.  The list of Setup options is 
displayed. 

2.  Click Options.  The Options Administration window is displayed [Figure 40]. 

3.  From the options command bar [Figure 40], click Reset User Options.  You are 
prompted to delete the customized options. 
 

 
 

4.  Click OK.  All options are returned to their default settings and a confirmation 
prompt is displayed. 
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5.  Click OK. 
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